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TEM PORARILY DISABLE "RE START NOW" 

DIALOG FROM XP'S AUT OMATIC UPDATES  
 
Automatic Updates is a great feature. Your computer stays protected from threats 
without worrying about ité but if it's 3am and I'm trying to play a video game, the 
last thing I want is for the automatic updates to pop up and remind me every 5 
minutes that I need to reboot, interrupting my gameé Drives me crazy! 
 

 
 
If you want to temporarily disable this popup message and delay rebooting, you can 
go about it one of two ways. I'm a command line junkie, so I just type this into a 
command prompt (make sure you use the quotes) 
 
net stop "automatic updates" 
 
Or you can open Control Panel \  Administrative Tools \  Services and click Stop on 
automatic updates. 
 

 
 
Do not disable the automatic updates service, just stop it. The next time you start up 
your computer, it will restart. 
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Note: If you open the Automatic Updates icon in Control Panel, it will automatically 
restart the service, which will make the dialog start popping up again. 

WINDOWS KEY USES  
 
In all honesty, I always thought the òWindows Keyó on my keyboard was just a 
nuisance. It was just the thing I accidentally hit once in a while and the darn Start 
menu would pop up. Turns out.  I was wrong; it has a lot of uses.  

 

When used in combination with other keys, hereõs what you can do: 
 

Windows Key + Tab: Cycle through the buttons in the Task Bar. 
 

Windows Key + D: Minimize or restore all windows 
 

Windows Key + E: Launch Windows Explorer 
 

Windows Key + F: Launch Search for Files 
 

Windows Key + Ctrl + F: Launch Search for Computers 
 

Windows Key + F1: Launch the Help and Support Center 
 

Windows Key + R: Launch the Run dialog box 
 

Windows Key + Pause/Break: Launch System Properties dialog box 
 

Windows Key + M: Minimizes all open windows. 
 

Windows Key + Shift + M: Undo minimize all windows 



XP Tips & Tricks  

Prepared by MHP Enterprises Page 3 xptipstricks 
 

 
Windows Key + L: Locks the workstation 

 
Windows Key + U: Launch the Utility Manager 

 
Windows Key + Ctrl + Tab: According to Microsoft: Moves focus from Start, to 

the Quick Launch toolbar, to the system tray. 

QUICK TIP: EASILY CO MPACT OUTLOOK 

DATA FILES  
 
If you are using Microsoft Outlook, all of your email is stored in a Personal Folders 
file (.pst), which tends to build up in size over time. If you want to save a little bit of 
hard drive space and maybe speed up Outlook, you can compact that file easily.  
 
Of course, this tip isn't very useful for experienced Outlook users, but we like to 
cover everything helpful even if it's fairly basic. 
 
Compacting Outlook Data Files 
From the Outlook main window, choose Data File Management from the File menu. 
 

 
 
The Account Settings dialog will open up on the Data Files tab. Highlight Personal 
Folders, which should be located on the local drive, then click on the Settings button. 
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Now with the Personal Folders dialog box open, click on Compact Now. 
 

 
 
A message indicating compacting is taking place will pop up then disappear when 
done. Now we can close out of the remaining windows. 
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This will work in both Outlook 2007 and 2003. If you notice Outlook becoming slow 
try out this quick fix. 
 
 

PREVENT WINDOWS XP F ROM CREATING 

THE THUMBS.DB THUMBN AIL CACHE FILES  
 
This is a guest post by Aseem Kishore from HelpDeskGeek.com, which focuses on 
providing Help Desk tips to IT Professionals.  
 
Windows has an annoying habit of displaying thumbnails for folders that you may not 
want thumbnails for, like the My Pictures folder. For me, it's better to have the My 
Pictures folder viewed in List or Details view and all of the folders underneath My 
Pictures to be shown as thumbnails.  
 
The really annoying thing is that even if you go to Tools, Options, View, and click on 
"Apply to All Folders", Windows may still revert back to thumbnail view! This 
happens because Windows will show a folder in thumbnail view if it finds a 
THUMBS.DB file in the folder.  
 

http://helpdeskgeek.com/
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THUMBS.DB is a cache file that basically is used by Windows in any folder it finds a 
picture or video so that the next time you view the folder, the thumbnails will be 
loaded faster so you don't have to wait. However, with the current speed of 
computers, it's pretty useless and only takes up more space on your computer. 
  

Disabling Thumbnails  
 
You can delete the file and the thumbnail view will go away, but only for some time 
before Windows re-creates it. You can prevent this from happening by disabling the 
thumbnail cache in Folder Options or via a registry hack.  
 
In Explorer, go to Tools, then Folder Options and click on the View tab.  
 

 
 
Check the box "Do not cache thumbnails" and click OK. Now Windows will not 
automatically create a THUMBS.DB file for a folder it deems needs thumbnails, 
which means you can set a folder view to list or detail and it will remain that way. 
Make sure to first delete the THUMBS.DB file if one existed already.  
 
You can still set the display of a folder manually by right-clicking on the folder and 
choosing Properties. Click on the Customize tab and choose from the list 
(Documents, Pictures, Photo Album, Music, etc)  
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Disabling Thumbnails with a Registry Hack  
 
Open the registry (regedit.exe) from the Run command and navigate to the following 
key: 
 
HKEY_CURRENT_USER \ Software\ Microsoft\ Windows\ CurrentVersion\  
Explorer\ Advanced 
 
Double click on the DisableThumbnailCache key in the right-hand pane and change 
the value to 1. If the key is not there, go to Edit, then New and choose DWORD 
Value to create one with the same name.  
 

 
 
Close the Registry and reboot your computer for the changes to take effect.  
 
If you have a lot of folders with lots of pictures, it would be best to disable the 
thumbnail cache because each picture in the cache is about 2KB, meaning a 1000 
pictures in one folder would result in a cache of 2MBs! 
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HOW TO MAKE ALL OF Y OUR FOLDERS 

VOdS bVS aO[S »dWSe¼ IN WIN DOWS XP  
 
To set Windows to display all of your folders with the same View, follow the steps 
outlined belowé 
 

First, select the View that you want to use. The following screenshots illustrate 
each choice ð  

 
Thumbnails 

 
 
Tiles 

 
 
Icons 

 
 
List  
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Details 

 
 

1. When youõve set the one you want to use, select Tools and then Folder 
Optionsé from the drop-down list.  

 

 
 

2. Select the View tab at the top, and before you click any buttons, review the 
options in the Advanced settings: pane. Be careful when changing the 
defaults, for example you may want to keep system files hidden, so they donõt 
accidentally get deleted. When youõre finished, click the Apply to All Folders 
button, and then the OK button.  

 

 
 

3. From now on when you open folders like My Computer or My Documents, 
they should all share the same View.  
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WINDOWS XP RECOVERY SYSTEM 

FEATURES  
 
The era of the dominant windows XP OS is coming to a slow but grinding halt as 
Windows Vista and Windows 7 (to be released in 2009) are taking the lead. But, there 
are those who still prefer Windows XP Home and Office Editions, and for their sake 
I have created this article on its very useful and lifesaving features.  
 
PCs over time tend to find the òneedó to start exhibiting problems, whether it be 
minor or not. The operating system could simply have booting issues, programs not 
feeling up to their òusualó tasks, and/or the random error messages along with the 
occasional crash here and there. To try and help lessen these issues Windows XP 
comes with 7 different PC-life saving methods that enable us to recover from these 
situations that sometimes barricade us from the outside world.  
 
The following methods do not always work, but there will be times that a lot of 
headaches can be avoided by learning how these methods work. In this tutorial/article 
I will give you a wide-ranging indication of each of these methods so that you can 
govern your computer a bit more efficiently. 
 

1) Automated System Recovery (ASR) 
 
Automated System Recovery (ASR) is an highly developed feature incorporated into 
the Microsoft Backup utility that will allow you to properly recover the Windows XP 
operating state in case of a disastrous system failure. By putting this feature to use you 
can effectively restore windows to a previous state from when you ran the ASR 
backup routine. This type of backup will first save your system settings on a floppy 
disk or a Compact Disc (CD) and then make a simple backup of the files youõve 
specified on your PC. You can then use this ASR disk/CD to fully restore your 
systems settings when you choose to reinstall Windows XP. 
 

2) Track Back W ith a Driver Rollback  
 
Driver rollback is a neat feature that allows you to òrollbackó a driver to its formerly 
installed version. This is exceptionally useful when youõve installed a new driver for a 
piece of hardware install on your PC and you start having issues either with that 
specific piece of hardware or other devices/applications on your machine. If such a 
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situation occurs you can remember to use Driver Rollback to rollback to the 
preceding driver that was installed before you upgraded it. 
 
To attain access to the Driver Rollback feature youõll have to double click on the 
System icon located in your Control Panel. Then click on the Hardware tab and 
then click on the Device Manager Button. This will pull up the Device Manager 
window where you can double-click on the piece of hardware that you had already 
installed and updated to enter itõs properties. As soon as youõre in the particular 
deviceõs properties section, you should click on the Driver tab. Within this tab you 
will see a button labeled Driver Rollback. Once you click on this button, it will ask 
for verification that you want to rollback the driver. Agree to this and follow the rest 
of the default instructions.  
 
If you try to rollback a device whose drivers have never been updated, Windows will 
tell you so. 
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3) Last of the Known Good Configuration  
 
Every single time you manage to load Windows XP successfully, Windows saves 
certain registry keys and applications settings on your PC. This way if you ever boot 
your computer and for some reason Windows fails to properly load, you can use the 
Last Known Good Configuration to boot Windows to the last known good settings 
 
To put this configuration to use as your booting Windows, press the F8 key as 
Windows starts, and then select the Last Known Good configuration option. Your 
PC will then take the action of loading Windows using these previously saved settings. 
 
 

HOW TO USE REMOTE AS SISTANCE IN 

WINDOWS XP   
 
Remote Assistance is a tool that has been designed to allow users to get remote 
support from a technician, IT Manager, friend, helpdesk, or vendor. Remote 
Assistance is very similar to remote packages like VNC Ultra or pcAnywhere, 
though perhaps not as fully featured. However, for the occasional support issue it 
should work just fine.  
 
If you know a òtechieó in your life that can help you, you can have them use Remote 
Assistance to help fix your issues. Now, all you have to do is follow these simple 
instructions to navigate the process and make Remote Assistance entirely work for 
you! 
 
Right-click on My Computer and choose Properties. Click on the Remote tab. 
Make sure Allow Remote Assistance invitations to be sent from this computer is 
enabled. 
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To ask a friend for help, click Start and then choose Help and Support. Click on 
Invite a friend to connect to your computer with Remote Assistance 

 

Click on Invite someone to help you to request assistance. 
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There are numerous methods by which you can commence a request. You can send 
an invitation via Windows Messenger, email (outlook, yahoo, etc.), or save a file and 
send through a different method or email program. In this case, I initiated my request 
by saving it as a file. These are the simple yet effective steps in order to invite 
someone you know or can trust to repair your PC remotely. 
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HOW TO DISABLE REMOT E ASSISTANCE 

AND REMOTE DESKTOP I N WINDOWS XP  
 

Why should you disable Remote Assistance and Remote Desktop? Because either service could 

be used or exploited by an attacker to gain remote access to your system. The steps to disable 

these services are outlined below..  

Click Start and then Control Panel  

 

Select Performance and Maintenance  

 

Select System  

 

Click the Remote tab and remove the check marks from the boxes labeled Allow 
Remote Assistance invitations to be sent from this computer and Allow 
users to connect remotely to this computer  

javascript:void(0)
javascript:void(0)
javascript:void(0)
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Click Apply and then OK. Should you ever need to re-enable remote assistance, youõll 
know how  
 

WINDOWS RUN COMMANDS  
 
Sometimes itõs easier to get to a program or Windows XP utility by just entering a 
command name. Sometimes itõs necessary. Below youõll find a list of over 100 òrunó 
commands.  
 
To execute one of these commands, click Start and select Run 
 

 
 
Enter the command you want to run and click OK 

http://www.simplehelp.net/images/disable.remote.desktop/xpremote00.jpg
http://www.simplehelp.net/images/disable.remote.desktop/xpremote00.jpg
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Program/Utility command 

    

Accessibility Controls access.cpl 

Add Hardware Wizard hdwwiz.cpl 

Add/Remove Programs appwiz.cpl 

Administrative Tools control admintools 

Automatic Updates wuaucpl.cpl 

Bluetooth Transfer Wizard fsquirt 

Calculator calc 

Certificate Manager certmgr.msc 

Character Map charmap 

Check Disk Utility chkdsk 

Clipboard Viewer clipbrd 

Command Prompt cmd 

Component Services dcomcnfg 

Computer Management compmgmt.msc 

Device Manager devmgmt.msc 

Direct X Control Panel (If Installed) directx.cpl 

Direct X Troubleshooter dxdiag 

Disk Cleanup Utility cleanmgr 

Disk Defragment dfrg.msc 

Disk Management diskmgmt.msc 

Disk Partition Manager diskpart 

Display Properties control desktop 

Display Properties desk.cpl 

javascript:void(0)
javascript:void(0)
javascript:void(0)
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Program/Utility command 

Display Properties (w/Appearance 
Tab Preselected) 

control color 

Dr. Watson System Troubleshooting 
Utility 

drwtsn32 

Driver Verifier Utility verifier 

Event Viewer eventvwr.msc 

File Signature Verification Tool sigverif 

Findfast findfast.cpl 

Folders Properties control folders 

Fonts control fonts 

Fonts Folder fonts 

Game Controllers joy.cpl 

Group Policy Editor (XP Pro only) gpedit.msc 

Iexpress Wizard iexpress 

Indexing Service ciadv.msc 

Internet Properties inetcpl.cpl 

IP Configuration (Display Connection 
Configuration) 

ipconfig /all 

IP Configuration (Display DNS Cache 
Contents) 

ipconfig 
/displaydns 

IP Configuration (Delete DNS Cache 
Contents) 

ipconfig /flushdns 

IP Configuration (Release All 
Connections) 

ipconfig /release 

IP Configuration (Renew All 
Connections) 

ipconfig /renew 

IP Configuration (Refreshes DHCP & 
Re-Registers DNS) 

ipconfig 
/registerdns 

IP Configuration (Display DHCP 
Class ID) 

ipconfig 
/showclassid 

IP Configuration (Modifies DHCP 
Class ID) 

ipconfig 
/setclassid 

Java Control Panel (If Installed) jpicpl32.cpl 

Java Control Panel (If Installed) javaws 
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Program/Utility command 

Keyboard Properties control keyboard 

Local Security Settings secpol.msc 

Local Users and Groups lusrmgr.msc 

Log Out Of Windows logoff 

Microsoft Chat winchat 

Mouse Properties control mouse 

Mouse Properties main.cpl 

Network Connections 
control 
netconnections 

Network Connections ncpa.cpl 

Network Setup Wizard netsetup.cpl 

Notepad notepad 

Nview Desktop Manager (If Installed) nvtuicpl.cpl 

Object Packager packager 

ODBC Data Source Administrator odbccp32.cpl 

On Screen Keyboard osk 

Password Properties password.cpl 

Performance Monitor perfmon.msc 

Performance Monitor perfmon 

Phone and Modem Options telephon.cpl 

Power Configuration powercfg.cpl 

Printers and Faxes control printers 

Printers Folder printers 

Private Character Editor eudcedit 

Quicktime (If Installed) QuickTime.cpl 

Regional Settings intl.cpl 

Registry Editor regedit 

Registry Editor regedit32 

Remote Desktop mstsc 

Removable Storage ntmsmgr.msc 

Removable Storage Operator 
Requests 

ntmsoprq.msc 
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Program/Utility command 

Resultant Set of Policy (XP Pro) rsop.msc 

Scanners and Cameras sticpl.cpl 

Scheduled Tasks control schedtasks 

Security Center wscui.cpl 

Services services.msc 

Shared Folders fsmgmt.msc 

Shuts Down Windows shutdown 

Sounds and Audio mmsys.cpl 

SQL Client Configuration cliconfg 

System Configuration Editor sysedit 

System Configuration Utility msconfig 

System File Checker Utility (Scan 
Immediately) 

sfc /scannow 

System File Checker Utility (Scan 
Once At Next Boot) 

sfc /scanonce 

System File Checker Utility (Scan On 
Every Boot) 

sfc /scanboot 

System File Checker Utility (Return to 
Default Setting) 

sfc /revert 

System File Checker Utility (Purge 
File Cache) 

sfc /purgecache 

System File Checker Utility (Set Cache 
Size to size x)  

sfc /cachesize=x 

System Properties sysdm.cpl 

Task Manager taskmgr 

Telnet Client telnet 

User Account Management nusrmgr.cpl 

Utility Manager utilman 

Windows Firewall firewall.cpl 

Windows Magnifier magnify 

Windows Management Infrastructure wmimgmt.msc 

Windows System Security Tool syskey 

Windows Update Launches wupdmgr 
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Program/Utility command 

Windows XP Tour Wizard tourstart 

Wordpad write 

 
 

HOW TO USE THE GROUP  POLICY EDITOR 

TO MANAGE LOCAL COMP UTER POLICY IN 

WINDOWS XP  
 
Summary:  This article describes how to use the Group Policy Editor to change local 
policy settings for the computer or for users of the computer. 
 

Uses of Group Policy  
In Microsoft Windows XP, you use Group Policy to define user and computer 
configurations for groups of users and computers. You create a specific desktop 
configuration for a particular group of users and computers by using the Group 
Policy Microsoft Management Console (MMC) snap-in. The Group Policy settings 
that you create are contained in a Group Policy Object (GPO), which is in turn 
associated with selected Active Directory containers, such as sites, domains, or 
organizational units (OUs). With the Group Policy snap-in you can specify policy 
settings for the following:  
 

¶ Registry-based policies. 
These include Group Policy for the Windows XP operating system and its 
components and for programs. To manage these settings, use the 
Administrative Templates node of the Group Policy snap-in.  

¶ Security options. 
These include options for local computer, domain, and network security 
settings.  

¶ Software installation and maintenance options. 
These are used to centrally manage program installation, updates, and removal.  

¶ Scripts options. 
These include scripts for computer startup and shutdown, and user logon and 
logoff.  

javascript:void(0)
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¶ Folder redirection options.  
These allow administrators to redirect users' special folders to the network.  

With Group Policy, you can define the state of users' work environment once and rely 
on the system to enforce the policies that you define.  
 

How to Start the Group Policy Edit or 
To start the group policy editor, follow these steps. 
 
NOTE : You must be logged on to the computer using an account that has 
administrator privileges in order to use Group Policy Editor.  

1. Click Start, and then click Run.  
2. In the Open box, type mmc, and then click OK.  
3. On the File menu, click Add/Remove Snap-in.  
4. Click Add.  
5. Under Available Stand-alone Snap-ins, click Group Policy, and then click 

Add.  
6. If you do not want to edit the Local Computer policy, click Browse to locate 

the group policy object that you want. Supply your user name and password if 
prompted, and then when you return to the Select Group Policy Object 
dialog box, click Finish.  
 

NOTE : You can use the Browse button to locate group policy objects linked to 
sites, domains, organizational units (OU), or computers. Use the default Group 
Policy Object (GPO) (Local Computer) to edit the settings on the local computer.  
 
7. Click Close, and then in the Add/Remove Snap-in dialog box, click OK. 

 
The selected GPO is displayed in the Console Root. 

 

How to Use the Group Policy Editor  
The Group Policy snap-in contains the following major branches:  

¶ Computer Configuration 
Administrators can use Computer Configuration to set policies that are applied 
to computer, regardless of who logs on to the computers. Computer 
Configuration typically contains sub-items for software settings, Windows 
settings, and administrative templates.  
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¶ User Configuration 
Administrators can use User Configuration to set policies that apply to users, 
regardless of which computer they log on to. User Configuration typically 
contains sub-items for software settings, Windows settings, and administrative 
templates. 

 

To use the group policy editor, follow these steps:  
1. Expand the GPO that you want. For example, Local Computer Policy.  
2. Expand the configuration item that you want. For example, Computer 

Configuration.  
3. Expand the sub-item that you want. For example, Windows Settings.  
4. Navigate to the folder that contains the policy setting that you want. The policy 

items are displayed in the right pane on the Group Policy Editor snap-in. 
 
NOTE : If no policy is defined for the selected item, right-click the folder that 
you want and then on the shortcut menu that appears, point to All Tasks, and 
then click the command that you want. The commands that are displayed on 
the All Tasks submenu are context sensitive. Only those commands that are 
applicable to the selected policy folder appear on the menu.  

5. In the Setting list, double-click the policy item that you want. 
 
NOTE : When you work with policy items in the Administrative Templates 
folder, click the Extended tab in the right pane of the MMC if you want to 
view more information about the selected policy item.  

6. Edit the settings of the policy in the dialog box that appears, and then click 
OK.  

7. When you are finished, quit the MMC. 
 
Example 
The following example illustrates the use of the Group Policy Editor to customize the 
Windows XP user interface. In this example, we will use the Group Policy Editor to 
temporarily remove the Turn Off Computer button from the Start menu. To do 
this, follow these steps:  

1. Start the Group Policy Editor and open the Local Computer policy by using 
the steps provided in the How to Start the Group Policy Editor section of this 
article. 
 
NOTE : You can start the Group Policy Editor snap-in from the command 

http://support.microsoft.com/kb/307882#3#3
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line. This automatically loads the Local Computer GPO. To do this, follow 
these steps:  

a. Click Start, and then click Run.  
b. In the Open box, type Gpedit.msc, and then click OK. 

2. Expand User Configuration (if it is not already expanded).  
3. Under User Configuration, expand Administrative Templates.  
4. Click Start Menu and Taskbar.  
5. In the right pane, double-click Remove and disable the Turn Off Computer 

button.  
6. Click Enabled, and then click Apply.  
7. Click Start. 

 
Notice that the Turn Off Computer button is no longer displayed.  

8. Select the Remove and disable the Turn Off Computer button Properties 
dialog box.  

9. Click Not Configured, then click Apply, and then click OK.  
10. Click Start. 

 
Notice that the Turn Off Computer button is again displayed on the Start 
menu.  

11. Quit the Group Policy Editor snap-in. 
 

REFERENCES  
For additional information about using computer management in Microsoft Windows 
XP, click the article number below to view the article in the Microsoft Knowledge 
Base:  
 
For more information about the use of Group Policies, visit the following Microsoft 
Web sites:  
http://technet.microsoft.com/library/Bb742376.aspx 
 
http://technet2.microsoft.com/windowsserver/en/technologies/featured/gp/default
.mspx 
 
http://technet2.microsoft.com/WindowsServer/en/Library/7b33dcd6-0ad2-44e8-
82f8-962425b6cf8e1033.mspx 
 
 

http://technet.microsoft.com/library/Bb742376.aspx
http://technet2.microsoft.com/windowsserver/en/technologies/featured/gp/default.mspx
http://technet2.microsoft.com/windowsserver/en/technologies/featured/gp/default.mspx
http://technet2.microsoft.com/WindowsServer/en/Library/7b33dcd6-0ad2-44e8-82f8-962425b6cf8e1033.mspx
http://technet2.microsoft.com/WindowsServer/en/Library/7b33dcd6-0ad2-44e8-82f8-962425b6cf8e1033.mspx
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SHUT DOWN WI NDOWS AT A SPECIFIC 

TIME FROM THE COMMAN D LINE  
 
If you've ever wanted to shut down Windows at a particular time, you can do it easily 
with the "at" command combined with the shutdown command. Just use the 
following syntax, and the computer will shut down at 2pm. (it uses military time).  
 

at 14:00 shutdown -s 
 
 

HOW TO SECURE YOUR W IRELESS 

NETWORK  
 
Here are 5 quick steps to help you secure your wireless network from unauthorized 
access. These steps are provided as general guidelines - for detailed help, please 
contact your hardware vendor. See the bottom of this page for links to some common 
wireless networking vendors.  
 
1. Download the latest firmware for your device. 
2. Change the administrator password. 
3. Change your SSID and turn off SSID Broadcasting 
4. Enable WPA 
5. Limit access by MAC addresses 
 

1. Download the latest firmware for your wireless router.  
 
Firmware is software thatõs embedded in a hardware device - in this case, your 
wireless router. The firmware that comes with your wireless router or wireless access 
point may be out of date. Download the latest firmware to ensure the best security 
and performance. 
 
As security vulnerabilities are discovered, patches to stop them are developed. These 
patches are often included in firmware updates. If youõre using the default firmware 
that came with your wireless router, there could be several known security holes that 
could allow someone to hijack your Internet connection, view the files on each of 
your networked computers and even steal passwords or credit card numbers.  




